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MSP430FR2311 LaunchPad™ Development Kit
(MSP‑EXP430FR2311)

Figure 1 shows the MSP430FR2311 LaunchPad™ development kit.

Figure 1. MSP430FR2311 LaunchPad Development Kit
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Getting Started

1.1

Introduction
The MSP430FR2311 LaunchPad™ Development Kit (MSP-EXP430FR2311) is an easy-to-use evaluation
module (EVM) for the MSP430FR2311 MCU. It contains everything needed to start developing on the
ultra-low-power MSP430FRx FRAM microcontroller platform, including onboard emulation for
programming, debugging, and energy measurements. The board features onboard buttons and LEDs for
quick integration of a simple user interface as well as an analog photodiode to showcase the integrated
analog peripherals. The MSP430FR2311 MCU device is the world's first MCU with a configurable lowleakage current sense amplifier, with 50-pA current leakage and 4KB of embedded FRAM (ferroelectric
random access memory), a nonvolatile memory known for its ultra-low power, high endurance, and highspeed write access.
Rapid prototyping is simplified by the 20-pin BoosterPack™ plug-in module headers, which support a wide
range of available BoosterPack plug-in modules. You can quickly add features like wireless connectivity,
graphical displays, environmental sensing, and much more. Design your own BoosterPack plug-in module
or choose among many already available from TI and third-party developers.
The out-of-box experience provided with the MSP-EXP430FR2311 MCU LaunchPad development kit
features the onboard analog photodiode. The current from the photodiode is converted by an integrated
operational amplifier to a voltage. That voltage is then sensed by an analog-to-digital converter and fed to
a timer module to pulse width modulate LED2. As more light hits the photodiode, LED2 brightens, and as
less light hits the photodiode, LED2 dims.
Free software development tools are also available, such as TI's Eclipse-based Code Composer Studio™
integrated development environment (IDE) and IAR Embedded Workbench® IDE. Both of these IDEs
support EnergyTrace™ technology for real-time power profiling and debugging when paired with the
MSP430FR2311 MCU LaunchPad development kit. More information about the LaunchPad development
kit, the supported BoosterPack plug-in modules, and available resources can be found on TI's LaunchPad
ecosystem portal.
The MSP-EXP430FR2311 is based on Experimental Silicon. The MSP430FR2311IPW20 device used in
this version of the MSP-EXP430FR2311 is a prototype device and has not met or completed Texas
Instruments internal reliability qualification requirements. The device used in this development kit is for
prototyping purposes only and is not intended to be used in production systems. Therefore, the device is
used on an "as is" basis and Texas Instruments makes no warranty of fitness for a specific purpose.

1.2

Key Features
•
•
•
•
•

MSP430™ ultra-low-power FRAM technology based the MSP430FR2311 16-bit MCU
EnergyTrace software available for ultra-low-power debugging
20 pin LaunchPad development kit standard leveraging the BoosterPack ecosystem
Onboard eZ-FET emulation
Two buttons and two LEDs for user interaction

1.3

What's Included

1.3.1

Kit Contents
• 1x MSP-EXP430FR2311 MCU LaunchPad development kit
• 1x micro USB cable
• 1x quick start guide

1.3.2
•
•
•

Software Examples
Out-of-box software
Blink LED
Software I2C
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First Steps: Out-of-Box Experience
An easy way to get familiar with the EVM is by using its preprogrammed out-of-box code. This code
demonstrates some key features from a user level.

1.4.1

Connecting to the Computer
Connect the LaunchPad development kit using the included USB cable to a computer. A green power LED
should illuminate. For proper operation, drivers are needed. TI recommends installing the TI Code
Composer Studio IDE or IAR Embedded Workbench for MSP430 IDE. Drivers are also available at
ti.com/MSPdrivers.

1.4.2

Running the Out-of-Box Demo
When connected to your computer, the LaunchPad development kit powers up and LED2 dims based on
the amount of ambient light hitting the photo diode, D1. Use a light source such as a flashlight or desk
lamp to illuminate D1 and the brightness of LED2 should increase depending on the intensity of the light
source.

1.5

Next Steps: Looking Into the Provided Code
After the EVM features have been explored, the fun can begin. It's time to open an integrated
development environment and start editing the code examples. Refer to Section 4 for available IDEs and
where to download them.
The quickest way to get started using the LaunchPad development kit is to use TI's Cloud Development
Tools, dev.ti.com. The cloud-based Resource Explorer provides access to all of the examples and
resources in MSPWare™ software. Code Composer Studio IDE Cloud is a simple Cloud-based IDE that
enables developing and running applications on the LaunchPad development kit.
The out-of-box source code and more code examples are provided for download from
www.ti.com/tool/msp-exp430fr2311. Code is licensed under BSD, and TI encourages reuse and
modifications to fit specific needs.
Section 3 describes all functions in detail and provides a project structure to help familiarize you with the
code.
Using the onboard eZ-FET emulator, debugging and downloading new code is simple. A USB connection
between the EVM and a PC through the provided USB cable is all that is needed.
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Hardware
Figure 2 shows an overview of the MSP-EXP430FR2311 hardware.

Figure 2. MSP-EXP430FR2311 Overview

2.1

Block Diagram
Figure 3 shows the block diagram.
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Figure 3. MSP-EXP430FR2311 Block Diagram
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Hardware Features
MSP430FR2311 MCU
The MSP430FR2311 MCU is the next device in TI's new ultra-low-power FRAM technology platform.
FRAM is a cutting edge memory technology, combining the best features of flash and RAM into one
nonvolatile memory.
Device features include:
• 1.8-V to 3.6-V operation
• 16-bit RISC architecture with up to 16-MHz system clock and 8-MHz FRAM access
• Up to 3.75KB of nonvolatile FRAM
• 126-µA/MHz active mode and 1-µA standby with RTC
• 8-channel 10-bit ADC
• Operational amplifier that supports multiple modes
• Enhanced comparator with integrated 6-bit DAC as reference voltage
• Transimpedance amplifier
• Three timers
• Direct memory access
• 16 GPIOs
P1.1/UCB0CLK/ACLK/C1/A1

1

20

P1.2/UCB0SIMO/UCB0SDA/TB0TRG/OA0-/A2/Veref-

P1.0/UCB0STE/SMCLK/C0/A0/Veref+

2

19

P1.3/UCB0SOMI/UCB0SCL/OA0O/A3

TEST/SBWTCK

3

18

P1.4/UCA0STE/TCK/OA0+/A4

RST/NMI/SBWTDIO

4

17

P1.5/UCA0CLK/TMS/TRI0O/A5

DVCC

5

16

P1.6/UCA0RXD/UCA0SOMI/TB0.1/TDI/TCLK/TRI0-/A6

DVSS

6

15

P1.7/UCA0TXD/UCA0SIMO/TB0.2/TDO/TRI0+/A7/VREF+

P2.7/TB0CLK/XIN

7

14

P2.0/TB1.1/COUT

P2.6/MCLK/XOUT

8

13

P2.1/TB1.2

P2.5/UCB0SOMI/UCB0SCL

9

12

P2.2/UCB0STE/TB1CLK

P2.4/UCB0SIMO/UCB0SDA

10

11

P2.3/UCB0CLK/TB1TRG

MSP430FR2311IPW20
MSP430FR2310IPW20

Figure 4. MSP430FR2311 MCU PW20 Pinout
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2.2.2

eZ-FET Onboard Emulator With EnergyTrace™ Software
To keep development easy and cost effective, TI's LaunchPad development kits integrate an onboard
emulator, which eliminates the need for expensive programmers. The MSP-EXP430FR2311 has the eZFET emulator (see Figure 5), which is a simple and low-cost debugger that supports all MSP430 MCU
derivatives.

Figure 5. eZ-FET Emulator
The MSP-EXP430FR2311 MCU LaunchPad development kit features EnergyTrace software. The
EnergyTrace software functionality varies across the MSP portfolio.
Table 1. EnergyTrace Software
Features

EnergyTrace Software

EnergyTrace++ Software

Current monitoring

✔

✔
✔

CPU State
Peripheral and system state

✔

Devices supported

All MSP430 MCUs

MSP430FR59xx and FR69xx
MCUs

Development tool required

MSP-FET or eZ-FET

MSP-FET or eZ-FET

The eZ-FET also provides a "backchannel" UART-over-USB connection with the host, which can be very
useful during debugging and for easy communication with a PC. The provided UART supports hardware
flow control (RTS and CTS), although by default these signals are not connected to the target.
The dotted line through J101 shown in Figure 5 divides the eZ-FET emulator from the target area. The
signals that cross this line can be disconnected by jumpers on J101, the isolation jumper block. More
details on the isolation jumper block are in Section 2.2.3.
The eZ-FET hardware can be found in the schematics in Section 6 and in the accompanying hardware
design files. The software and more information about the debugger can be found on the eZ-FET wiki.
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Emulator Connection: Isolation Jumper Block
The isolation jumper block at jumper J101 allows the user to connect or disconnect signals that cross from
the eZ-FET domain into the MSP430FR2311 MCU target domain. This includes eZ-FET Spy-Bi-Wire
signals, application UART signals, and 3.3-V and 5-V power.
Reasons to open these connections:
• To remove any and all influence from the eZ-FET emulator for high-accuracy target power
measurements
• To control 3-V and 5-V power flow between the eZ-FET and target domains
• To expose the target microcontroller pins for other use than onboard debugging and application UART
communication
• To expose the programming and UART interface of the eZ-FET so that it can be used for devices other
than the onboard microcontroller
Table 2. Isolation Block Connections (1)
Jumper
GND

(1)

8

Description
Ground

5V

5-V VBUS from USB

3V3

3.3-V rail, derived from VBUS in the eZ-FET domain

RXD <<

Backchannel UART: The target FR2311 receives data through this signal. The arrows indicate the direction of the
signal.

TXD >>

Backchannel UART: The target FR2311 sends data through this signal. The arrows indicate the direction of the
signal.

SBW RST

Spy-Bi-Wire emulation: SBWTDIO data signal. This pin also functions as the RST signal (active low).

SBW TST

Spy-Bi-Wire emulation: SBWTCK clock signal. This pin also functions as the TST signal.

Also see Figure 6.
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USB Connector

eZ-FET

USB
in

eZ-FET
Debug
Probe

out
LDO
EnergyTrace

Target MSP430
MCU

BoosterPack Header

Spy-Bi-Wire (SBW)
Emulation

Application UART

3.3V Power

5V Power

BoosterPack Header

MSP430 Target

Isolation
Jumper Block

Figure 6. eZ-FET Isolation Jumper Block Diagram

2.2.4

Application (or "Backchannel") UART
The backchannel UART allows communication with the USB host that is not part of the target application's
main functionality. This is very useful during development, and also provides a communication channel to
the PC host side. This can be used to create graphical user interfaces (GUIs) and other programs on the
PC that communicate with the LaunchPad development kit.
Figure 6 shows the pathway of the backchannel UART. The backchannel UART is the UART on
eUSCI_A0.
On the host side, a virtual COM port for the application backchannel UART is generated when the
LaunchPad development kit enumerates on the host. You can use any PC application that interfaces with
COM ports, including terminal applications like Hyperterminal or Docklight, to open this port and
communicate with the target application. You need to identify the COM port for the backchannel. On
Windows PCs, Device Manager can assist.

Figure 7. Application Backchannel UART in Device Manager
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The backchannel UART is the "MSP Application UART1" port. In this case, Figure 7 shows COM13, but
this port can vary from one host PC to the next. After you identify the correct COM port, configure it in
your host application according to its documentation. You can then open the port and begin
communication to it from the host.
On the target MSP430FR2311 MCU side, the backchannel is connected to the eUSCI_A0 module. The
eZ-FET has a configurable baud rate; therefore, it is important that the PC application configures the baud
rate to be the same as what is configured on the eUSCI_A0.
2.2.5

Special Features

2.2.5.1

Smart Analog Combo (SAC)

The MSP430FR2311 MCU LaunchPad development kit features pins to access the smart analog combo
on the device. These pins are accessed on jumpers J7, J8 and J9 where the smart analog combo
operational amplifier is connected to the onboard photodiode circuit. These pins are also connected to the
BoosterPack plug-in module header pins. For applications that use the SAC and a connected BoosterPack
plug-in module, be sure to check for any pin conflicts. The photodiode circuit can be disconnected from
the SAC using jumpers J7, J8 and J9. The user can connect an external analog sensor circuit to the SAC
by removing jumpers J7, J8 and J9 and connecting their circuit to the appropriate header pins through the
BoosterPack plug-in module headers or the jumpers near the light sensor circuit.
To adjust the light sensor circuits' sensitivity the user can adjust either the software or the hardware. By
changing the value of R3 and C6 the user can change the operational amplifiers low-pass filter and
sensitivity to the photodiodes current. The user can also adjust the calculations performed in the software
to adjust the sensitivity of the circuit to their desired level.

2.3

Power
The board was designed to accommodate various powering methods, including through the onboard eZFET as well as external or BoosterPack power (see Figure 8).

Figure 8. MSP-EXP430FR2311 Power Block Diagram
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2.3.1

eZ-FET USB Power
The most common power-supply scenario is from USB through the eZ-FET debugger. This provides 5-V
power from the USB and also regulates this power rail to 3.3 V for eZ-FET operation and 3.3 V to the
target side of the LaunchPad development kit. Power from the eZ-FET is controlled by jumper J101. For
3.3 V, make sure that a jumper is connected across the J101 3V3 terminal.

2.3.2

BoosterPack Plug-In-Module and External Power Supply
Header J5 is present on the board to supply external power directly. It is important to comply with the
device voltage operation specifications when supplying external power. The MSP430FR2311 MCU has an
operating range of 1.8 V to 3.6 V. More information can be found in MSP430FR231x Mixed-Signal
Microcontrollers.

2.4

Measure MSP430 MCU Current Draw
To measure the current draw of the MSP430FR2311 MCU using a multi-meter, use the 3V3 jumper on the
jumper isolation block. The current measured includes the target device and any current drawn through
the BoosterPack headers.
To measure ultra-low power, follow these steps:
1. Remove the 3V3 jumper in the isolation block, and attach an ammeter across this jumper.
2. Consider the effect that the backchannel UART and any circuitry attached to the MSP430FR2311 MCU
may have on current draw. Consider disconnecting these at the isolation jumper block, or at least
consider their current sinking and sourcing capability in the final measurement.
3. Make sure there are no floating inputs/outputs (I/Os). These cause unnecessary extra current draw.
Every I/O should either be driven out or, if it is an input, should be pulled or driven to a high or low
level.
4. Begin target execution.
5. Measure the current. Keep in mind that if the current levels are fluctuating, it may be difficult to get a
stable measurement. It is easier to measure quiescent states.
EnergyTrace software allows you to compare various current profiles and better optimize your energy
performance!

2.5

Clocking
The MSP-EXP430FR2311 provides an input for an external clock in addition to the internal clocks in the
device. No crystal is populated by default to allow all pins to connect to the BoosterPack header. The user
can choose to populate any 32.768 kHz crystal that will fit onto the provided footprint. One option is
recommended below:
• Y1: 32-kHz Epson FC-135R 12.5pF crystal, Part #: X1A0001410014
The 32-kHz crystal allows for lower LPM3 sleep currents than do the other low-frequency clock sources.
Therefore, the presence of the crystal allows the full range of low-power modes to be used. If using the
external Y1 crystal footprint the user will need to remove the 0-ohm resistors R4 and R5 and populate C2
and C3 with the appropriate tuning capacitors for the crystal that is used.
The internal clocks in the device default to the following configuration:
• MCLK: DCO at 1 MHz
• SMCLK: DCO at 1 MHz
• ACLK: REFO at 32.768 kHz
For more information about configuring internal clocks and using the external oscillators, see the
MSP430FR4xx and MSP430FR2xx Family User's Guide.
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Using the eZ-FET Emulator With a Different Target
The eZ-FET emulator on the LaunchPad development kit can interface to most MSP430 MCU derivative
devices, not just the onboard MSP430FR2311 MCU target device.
To do this, disconnect every jumper in the isolation jumper block. This is necessary, because the emulator
cannot connect to more than one target at a time over the Spy-Bi-Wire (SBW) connection.
Next, make sure the target board has proper connections for SBW. Note that to be compatible with SBW,
the capacitor on RST/SBWTDIO cannot be greater than 2.2 nF. The documentation for designing MSP430
MCU JTAG interface circuitry is the MSP430 Hardware Tools User's Guide.
Finally, wire together these signals from the emulator side of the isolation jumper block to the target
hardware:
• 5 V (if 5 V is needed)
• 3.3 V
• GND
• SBWTDIO
• SBWTCK
• TXD (if the UART backchannel is to be used)
• RXD (if the UART backchannel is to be used)
This wiring can be done either with jumper wires or by designing the board with a connector that plugs into
the isolation jumper block.

2.7

BoosterPack Plug-in Module Pinout
The LaunchPad development kit adheres to the 20-pin LaunchPad pinout standard. A standard was
created to aid compatibility between the LaunchPad development kit and BoosterPack plug-in module
tools across the TI ecosystem.
The 40-pin standard is compatible with the 20-pin standard that is used by other LaunchPad development
kit's like the MSP-EXP430FR6989. This allows some subset of functionality of 40-pin BoosterPack
modules to be used with 20-pin LaunchPad development kits.
While most BoosterPack plug-in modules are compliant with the standard, some are not. The MSPEXP430FR2311 MCU LaunchPad development kit is compatible with all 20-pin BoosterPacks plug-in
modules that are compliant with the standard. If the reseller or owner of the BoosterPack plug-in module
does not explicitly indicate compatibility with the MSP-EXP430FR2311 MCU LaunchPad development kit,
compare the schematic of the candidate BoosterPack with the LaunchPad to ensure compatibility. Keep in
mind that sometimes conflicts can be resolved by changing the MSP430FR2311 MCU pin function
configuration in software. More information about compatibility can also be found at
www.ti.com/launchpad.
Figure 9 shows the 20-pin pinout of the MSP430FR2311 MCU LaunchPad development kit.
Note that software configuration of the pin functions plays a role in compatibility. The LaunchPad
development kit side of the dashed line in Figure 9 shows all of the functions for which the
MSP430FR2311 MCU's pins can be configured. This can also be seen in the MSP430FR2311 MCU data
sheet. The BoosterPack plug-in module side of the dashed line shows the standard. The LaunchPad
development kit function whose color matches the BoosterPack plug-in module function shows the specific
software-configurable function by which the MSP430FR2311 LaunchPad development kit adheres to the
standard.
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Figure 9. LaunchPad Development Kit To Boosterpack Plug-in Module Connector Pinout

2.8
2.8.1

Design Files
Hardware
Section 6 shows the schematics. All design files including schematics, layout, bill of materials (BOM),
Gerber files, and documentation are available in the MSP-EXP430FR2311 Hardware Design Files.

2.8.2

Software
All design files including TI-TXT object-code firmware images, software example projects, and
documentation are available in the MSP-EXP430FR2311 Software Examples.

2.9

Hardware Change log
Table 3. Hardware Change Log
PCB Revision

Description

1.0

Initial release

1.1

Updated rear silkscreen to current LaunchPad
standards.
Added CE marking to silkscreen.
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Software Examples
Three software examples are included with the MSP430FR2311 MCU LaunchPad development kit (see
Table 4), which can be found in the zip source folder in the MSP-EXP430FR2311 Software Examples and
are also available inside MSPWare.
Table 4. Software Examples
BoosterPack
Plug-In Module
Required

Demo Name

Description

More Details

OutOfBox_MSP430FR2311

None

The out-of-box demo preprogrammed on the LaunchPad
development kit from the factory. Demonstrates features of
MSP430FR2311 MCU device.

Section 3.1

BlinkLED_MSP430FR2311

None

Blinks an LED on the LaunchPad development kit at a fixed
interval.

Section 3.2

Reads digital ambient light sensor utilizing software I2C
master example.

Section 3.3

BOOSTXLEDUMKII_SoftwareI2C_
MSP430FR2311

BOOSTXLEDUMKII

To use any of the software examples with the LaunchPad development kit, you must have an integrated
development environment (IDE) that supports the MSP430FR2311 microcontroller (see Table 5).
Table 5. IDE Minimum Requirements for MSP-EXP430FR2311
Code Composer Studio™ IDE

IAR Embedded Workbench® IDE

Version 6.1 or later

Version 6.40.2 or later

For more details on how to get started quickly, and where to download the latest Code Composer Studio
and IAR Embedded Workbench IDEs, see Section 4.1.

3.1

Out-of-Box Software Example
This section describes the functionality and structure of the out-of-box software that is preloaded on the
EVM.
This demo shows how to use the op-amp module, combined with the timer, ADC, and LED, to implement
a simple light sensor circuit for ultra-low-power applications.
Upon powering up the out-of-box demo, LED1 will toggle at startup and then LED2 will dim based on the
amount of ambient light in the area. If the user covers the photo diode, D1, with a piece of paper or their
hand the brightness of LED2 should dim based on the amount of light. If the user illuminates the photo
diode with a light source LED2 should increase in brightness until the ADC saturates and the LED reaches
full brightness. The current ADC reading is saved to FRAM memory before the device re-enters LPM3.

3.1.1

Source File Structure
The project is split into multiple files. This makes it easier to navigate and reuse parts of it for other
projects.
Table 6. Source File and Folders
Name

14

Description

main.c

The out-of-box demo main function, initializations, shared ISRs, and so on.

Library: Driverlib

Device driver library

MSP430FR2311 LaunchPad™ Development Kit (MSP‑EXP430FR2311)
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3.1.2

Power Measurement
The MSP430FR2311 MCU is ultra-low-power and its out-of-box software provides an example of an ultralow-power application. To measure the applications power we will use EnergyTrace software integrated in
Code Composer Studio IDE v6.1 or later.
After importing the out-of-box project into Code Composer Studio IDE and connecting the LaunchPad
development kit, follow the instructions below. For more information on how to import a project, see
Section 4.1.2.

1. Click Debug
to program the LaunchPad development kit and start the
Debug session.
2. Click Proceed on the ULP Advisor to continue to the Debug session.
3. Select View → Other → EnergyTrace → EnergyTrace software from the menu bar at the top and then
click OK.
4. Click the Set measurement duration icon
and select "10 sec" from the drop-down menu.
5. Remove the following jumpers from the LaunchPad development kit:
J11 at LED2
RXD at J101
TXD at J101
6. Select Run → Free Run (Ctrl+F8) from the menu bar at the top.
7. When finished, review the power profile of the application and note the battery life of more than 400
days when using a CR2032.

3.2

Blink LED Example
This very simple software example shows how to software toggle a GPIO to blink an LED on the
LaunchPad development kit.

3.2.1

Source File Structure
The project is split into multiple files (see Table 7). This makes it easier to navigate and reuse parts of it
for other projects.
Table 7. Source File and Folders
Name

Description

main.c

The blink LED main function

Library: Driverlib

Device driver library

The main code uses the MSP430 Driver Library to halt the watchdog timer and to configure or toggle the
GPIO pin connected to the LED inside a software loop.
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Software I C Example
This simple software example shows how to implement software controlled I2C master communication on
the LaunchPad development kit.

3.3.1

Source File Structure
The project is split into multiple files (see Table 8). This makes it easier to navigate and reuse parts of it
for other projects.
Table 8. Source File and Folders
Name

16

Description

main.c

The out-of-box demo main function, initializations, shared ISR's, etc

MSP430_SWI2C_Master.c

Main function file for software I2C master communication

opt3001.c

Ambient light sensor library

Library: Driverlib

Device driver library
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4

Resources

4.1

Integrated Development Environments
Although the source files can be viewed with any text editor, more can be done with the projects if they're
opened with a development environment like Code Composer Studio IDE, IAR Embedded Workbench
IDE, or Energia.

4.1.1

TI Cloud Development Tools
TI's Cloud-based software development tools provide instant access to MSPWare software content and a
web-based IDE.

4.1.1.1

TI Resource Explorer Cloud

TI Resource Explorer Cloud provides a web interface for browsing examples, libraries and documentation
found in MSPWare software without having to download files to your local drive (see Figure 10).
Go check out TI Resource Explorer Cloud now at https://dev.ti.com/.

Figure 10. TI Resource Explorer Cloud
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Code Composer Studio Cloud

Code Composer Studio Cloud (CCS Cloud) is a web-based IDE that enables you to quickly create, edit,
build, and debug applications for the LaunchPad development kit (see Figure 11). No need to download
and install large software packages, simply connect the LaunchPad development kit and begin. Select
from a large variety of examples in MSPWare software and Energia or develop your own application. CCS
Cloud supports debug features such as execution control, breakpoints, and viewing variables.
A full comparison between CCS Cloud and CCS Desktop is available at
https://dev.ti.com/about#cloudordesktop.
Go check out Code Composer Studio Cloud now at https://dev.ti.com/.

Figure 11. CCS Cloud

4.1.2

Code Composer Studio IDE
Code Composer Studio Desktop is a professional integrated development environment that supports TI's
microcontroller and embedded processors portfolio. Code Composer Studio IDE comprises a suite of tools
used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source code
editor, project build environment, debugger, profiler, and many other features.
Learn more about CCS IDE and download it at www.ti.com/tool/ccstudio.
CCS v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen, use
Project>Import Existing CCS Eclipse Project. Direct it to the desired demo's project directory that contains
main.c (see Figure 12).
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Figure 12. Directing the Project>Import Function to the Demo Project
Selecting the \CCS subdirectory also works. The CCS-specific files are located there.
When you click OK, Code Composer Studio should recognize the project and allow you to import it. The
indication that Code Composer Studio has found it is that the project appears in the box shown in
Figure 13, and it has a checkmark to the left of it.

Figure 13. When CCS Has Found the Project
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Sometimes Code Composer Studio IDE finds the project but does not show a checkmark; this might mean
that your workspace already has a project by that name. You can resolve this by renaming or deleting that
project. (Even if you do not see it in the Code Composer Studio IDE workspace, be sure to check the
workspace directory on the file system.)
4.1.3

IAR Embedded Workbench for Texas Instruments MSP430
IAR Embedded Workbench for MSP430 is another very powerful integrated development environment that
allows you to develop and manage complete embedded application projects. It integrates the IAR C/C++
Compiler, IAR Assembler, IAR ILINK Linker, editor, project manager, command line build utility, and IAR
C-SPY® Debugger.
Learn more about IAR Embedded Workbench for MSP430 and download it at
supp.iar.com/Download/SW/?item=EW430-EVAL.
IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.
The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project….
Although the software examples have all of the code required to run them, IAR users may download and
install MSPWare software, which contains MSP430 MCU libraries and the TI Resource Explorer. These
are already included in a Code Composer Studio IDE installation (unless the user selected otherwise).

4.1.4

Energia
Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and
Arduino framework. Energia provides unmatched ease of use through very high-level APIs that can be
used across hardware platforms. Energia is a light-weight IDE that does not have the full feature set of
Code Composer Studio IDE or IAR. However, Energia is great for anyone who wants to get started very
quickly or who does not have significant coding experience.
Learn more about Energia and download it at www.energia.nu.

4.2

LaunchPad Websites
More information about the LaunchPad development kit, supported BoosterPacks plug-in modules, and
available resources can be found at:
• MSP-EXP430FR2311 Tool Folder: Resources specific to this particular LaunchPad development kit
• TI's LaunchPad development kit portal: Information about all LaunchPad development kits from TI

4.3

MSPWare Software and TI Resource Explorer
TI Resource Explorer is a tool integrated into Code Composer Studio IDE that allows you to browse
through available design resources (see Figure 14). TI Resource Explorer will help you quickly find what
you need inside packages including MSPWare software, ControlSUITE™ software, TivaWare™ software,
and more. TI Resource Explorer is well organized to find everything that you need quickly, and you can
import software projects into your workspace in one click!
TI Resource Explorer Cloud is one of the TI Cloud Development tools, and is tightly integrated with CCS
Cloud. See Section 4.1.1.2 for more information.
MSPWare software is a collection of code examples, software libraries, data sheets, and other design
resources for all MSP devices delivered in a convenient package – essentially everything developers need
to become MSP experts!
In addition to providing a complete collection of existing MSP design resources, MSPWare software also
includes a high level API called MSP Driver Library. This library makes it easy to talk to MSP hardware.
More information can be found at www.ti.com/tool/mspware.
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Figure 14. Using TI Resource Explorer to Browse MSPWare
Inside TI Resource Explorer, these examples and many more can be found, and easily imported into Code
Composer Studio with one click.

4.4

FRAM Utilities
The TI MSP430 FRAM MCU Utilities is a collection of embedded software utilities that leverage the ultralow-power and virtually unlimited write endurance of FRAM. The utilities are available for MSP430FRxx
FRAM microcontrollers and provide example code to help start application development.

4.5
4.5.1

MSP430FR2311MCU
Device Documentation
At some point, you will probably want more information about the MSP430FR2311 microcontrollers.
Table 9 summarizes how the documentation is organized for every MSP device.
Table 9. How MSP Device Documentation is Organized
Document

For MSP430FR2311 MCU

Description

Device family user's guide

MSP430FR4xx and MSP430FR2xx
Family User's Guide

Architectural information about the device, including all modules
and peripherals such as clocks, timers, ADC, and so on.

MSP430FR231x Mixed-Signal
Microcontrollers data sheet

Device-specific information and all parametric information for this
device.

Device-specific
data sheet

4.5.2

MSP430FR2311 MCU Code Examples
MSP430FR231x Code Examples is a set of very simple C examples that demonstrate how to use the
entire set of peripherals on the MSP430 MCU, including serial communication, ADC10, SAC, TRI,
Timer_B, and others, through direct register access.
Every MSP derivative has a set of these code examples. When starting a new project or adding a new
peripheral, these examples serve as a great starting point.

SLAU664B – February 2016 – Revised August 2017
Submit Documentation Feedback

MSP430FR2311 LaunchPad™ Development Kit (MSP‑EXP430FR2311)

Copyright © 2016–2017, Texas Instruments Incorporated

21

Resources

4.5.3

www.ti.com

MSP430 MCU Application Notes and TI Designs
There are many application notes that can be found at www.ti.com/msp430, as well as TI Designs with
practical design examples and topics.

4.6

Community Resources

4.6.1

TI E2E™ Online Community
Search the forums at e2e.ti.com. If you cannot find your answer, post your question to the community.

4.6.2

Community-at-Large
Many online communities focus on the LaunchPad development kits– for example, www.43oh.com. You
can find additional tools, resources, and support from these communities.

5

FAQ
Q: I can't get the backchannel UART to connect. What's wrong?
A:
•
•
•

Check the following:
Do the baud rate in the host's terminal application and the eUSCI settings match?
Are the appropriate jumpers in place on the isolation jumper block?
Probe on RXD and send data from the host. If you don't see data, it might be a problem on the host
side.
• Probe on TXD while sending data from the MSP. If you don't see data, it might be a configuration
problem with the eUSCI module.
• Consider the use of the hardware flow control lines (especially for higher baud rates).
Q: The MSP G2 LaunchPad development kit had a socket, allowing me change the target device.
Why doesn't this LaunchPad development kit use one?
A: This LaunchPad development kit provides more functionality, and this means using a device with more
pins. Sockets for devices with this many pins are too expensive for the target price of the LaunchPad
development kit.
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6

Schematics
Figure 15 to Figure 20 show the schematics for the MSP-EXP430FR2311, which are also available in the hardware design files.

Copyright © 2017, Texas Instruments Incorporated

Figure 15. Schematics (1 of 6)
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Figure 16. Schematics (2 of 6)
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Figure 17. Schematics (3 of 6)
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Figure 18. Schematics (4 of 6)
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Figure 19. Schematics (5 of 6)
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Figure 20. Schematics (6 of 6)
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STANDARD TERMS FOR EVALUATION MODULES
1.

Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or
documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility
evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software
1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2

Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License
Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM
to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.
2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING
Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers
and application risks associated with handling electrical mechanical
components, systems, and subsystems.
User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up
and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI’s instructions for
electrical ratings of interface circuits such as input, output and
electrical loads.
NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3

Regulatory Notices:
3.1 United States
3.1.1

Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2

For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.
FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.
FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:
•
•
•
•

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1

For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.
Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.
Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.
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Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur
3.3 Japan
3.3.1

Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に
輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2

Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1.

2.
3.

Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,
Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or
Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1.
2.
3.

電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用
いただく。
実験局の免許を取得後ご使用いただく。
技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ
ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル
3.3.3

Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1

For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):
This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.
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EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.
4.3 Safety-Related Warnings and Restrictions:
4.3.1

User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user
guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2

EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.
5.

Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6.

Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT
LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.
6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7.
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USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

www.ti.com
8.

Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,
INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.
8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9.

Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.
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IMPORTANT NOTICE AND DISCLAIMER
TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third
party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable
warranties or warranty disclaimers for TI products.
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